
PROGRAMA PARA EL APOYO AL TRABAJO DE CAMPO Y 
EDICIÓN DE MAPAS DE ORIENTACIÓN

Introducción
Se trata de un programa que nace con varios objetivos, relacionados con el trabajo de campo y la edición 

de mapas para el deporte de orientación. Son los siguientes:

• Realizar la grabación de datos recogidos de un dispositivo GPS  , pero caracterizándolos de la misma 
forma que se identifican en el programa de edición OCAD. Por ejemplo, el usuario puede decidir si 
se trata de un punto, una línea o un área. Y para cada uno de ellos, además de tomar sus 
coordenadas, también podrá decidir qué tipo de objeto OCAD es (una roca = 206.0; terreno abierto 
= 401.0; etc). En la imagen superior, son las opciones del menú “Gestionar”

• Facilitar la importación y exportación de datos entre los formatos más extendidos  . Ya que el usuario 
ha recogido datos y se ha preocupado de caracterizarlos con el tipo OCAD que les corresponde, 
¿por qué no “dibujar” por él un mapa OCAD a partir de esos datos? Además, un formato muy 
extendido en el mundo de los GPS es el denominado GPX. Si un usuario cuenta con un dispositivo 
GPS autónomo capaz de guardar tracks y waypoints, probablemente sea capaz de guardarlos en un 
ordenador en este formato. Este programa puede importar los datos procedentes de un fichero 
GPX. Y si volvemos a la pregunta anterior, ¿por qué no “dibujar” por él un mapa OCAD a partir de 
esos datos? En la imagen superior, son las opciones del menú “Archivo”

• Crear una tablilla de dibujo electrónica  . Se trata de ofrecer los mismos elementos que un cartógrafo 
lleva adheridos a su tablilla en el campo: una imagen de fondo, unas hojas transparentes para poder 
dibujar sobre ellas, rotuladores de varios grosores y colores, una regla para dibujar líneas de un 
cierto tamaño en un cierto ángulo, una goma para borrar los errores, etc. Además de todo esto (que 
normalmente se lleva en una tablilla) también se muestra la posición del GPS como ayuda a la 
decisión en cuanto al posicionamiento en el campo. En la imagen superior, son las opciones del 
menú “Trabajo de campo”

• Realizar una adaptación para su uso en tablets con sistema Android  . Más variedad en el mercado, 
más económicos. Ya existe una primera versión para Android. Este documento sirve para aprender 
acerca del funcionamiento del programa también en Android. Lo que cambia, básicamente, es el 
aspecto de las pantallas y el interfaz, pero las funciones y la forma de trabajar es la misma. En este 
documento se añaden notas específicas para este sistema operativo cuando es necesario.



Detalle de funciones. Menú Archivo

Este menú facilita la importación/exportación y grabación de datos. El programa utiliza un formato de 
archivo interno. Todos los datos que se graban con el programa se almacenan en un fichero denominado 
“Registros.xml”. El trabajo de una sesión se almacena en memoria. Es necesario pulsar la opción “Grabar” 
periódicamente para que queden almacenados en el fichero (y, por lo tanto, que no se pierdan). 

Una forma sencilla de eliminar todos los registros existentes es pulsando la opción “Reiniciar”. Esto borra 
todos los datos.

Si alguien nos pasa o si encontramos en Internet un conjunto de datos interesantes, pero estos se 
encuentran en formato GPX, la opción “Importar GPX” los lee y los integra en el programa. 

En el ejemplo, el usuario ha encontrado en Internet el track del recorrido de un participante en el 
campeonato de España 2011. Como no sabemos si los datos están caracterizados de alguna forma, le decimos 
al programa que ningún campo del fichero contiene el dato de qué tipo OCAD se va a usar. Entonces, se 
tiene que definir cuáles van a ser los tipos OCAD por defecto, tanto para puntos como para líneas. En este 
caso, los waypoints se interpretarán como objetos especiales hechos por el hombre y los tracks como 
caminos. Por último, al no sobreescribir registros lo que estamos diciendo es que queremos añadirlos a los 
registros que ya tengamos almacenados en el programa. Si el GPS del usuario permite dar nombre y/o 
descripción a los puntos, entonces se puede realizar la visita al campo añadiendo puntos y escribiendo el tipo 
OCAD que corresponde a cada elemento. Al utilizar la opción de importar podemos decirle al programa en 
cuál de los campos viene ese dato (tipo OCAD en…)



Los datos que se han ido almacenando desde el programa, ya sea por haberlos recogido a través de GPS, 
ya sea por haberlos importado desde un fichero en formato GPX, se pueden exportar para usarlos desde 
otros lugares o por otras personas. Se puede crear un mapa OCAD directamente, pulsando la opción 
“Generar OCAD”.

El programa permite especificar entre dos versiones de OCAD (inicialmente se había creado una 
exportación para OCAD 7; como la versión 6 es gratuita, se decidió crear también esa opción para facilitar su 
uso por parte de usuarios que no tienen una versión de pago). Se puede decidir si se van a usar coordenadas 
de papel (eliminando la información de georreferenciación) o de mundo real (manteniendo la 
georreferenciación). El programa realiza la conversión automática desde coordenadas de tipo longitud-latitud 
según el sistema WGS84 (procedentes del GPS) hacia coordenadas UTM (con destino al programa OCAD). 
La zona UTM no sería necesaria, en teoría, ya que la conversión de datos permite su identificación. Pero si el 
usuario se encuentra trabajando entre dos zonas UTM podría dar lugar a errores, con lo que resulta más 
conveniente que el usuario diga qué zona quiere utilizar.

Otro formato de exportación es el GPX, mediante la opción “Generar GPX”. Esto permite ver y utilizar 
los datos que el usuario ha estado registrando en otros programas externos, como por ejemplo Google Earth. 
Al pulsar esta opción, los datos de trabajo (los cuales se van grabando en el fichero Registros.xml en un 
formato particular) se guardan automáticamente en un fichero denominado “Registros.gpx”, el cual se 
encuentra en ese formato utilizable desde otros programas de terceros.

Como resumen, las siguientes imágenes muestran la secuencia que consiste en haber importado unos 
datos GPX encontrados en Internet, su exportación a OCAD 6, su exportación a GPX y visualización de los 
datos en Google Earth.





Detalle de funciones. Menú Gestionar

Este menú facilita la comunicación con un dispositivo GPS y la grabación de datos vectoriales. El GPS se 
tiene que conectar a través de puerto serie, ya sea físico o virtual (USB, Bluetooth, Garmin Spanner, etc.)

NOTA PARA ANDROID: la versión Android sólo permite actualmente la conexión con dispositivos 
GPS a través de Bluetooth. Se está trabajando para poder usar el GPS interno del smartphone o tablet (si 
tiene uno).

La primera opción “Abrir puerto” intenta hacer lo que dice, abrir el puerto de comunicaciones para 
recibir datos del GPS. El formato de comunicación es el NMEA. Si todo va bien, el programa muestra en 
pantalla los datos que está recibiendo desde el GPS. Después de haber configurado por primera vez el 
programa, este es el primer paso que se tiene que realizar cada vez que se arranca para iniciar la comunicación 
con el GPS.

La opción “Lectura” realiza una lectura de coordenadas y muestra los datos en pantalla.

La opción “Centroide” realiza lecturas de forma periódica y calcula un centroide de la coordenada, es 
decir, una corrección en base a tomar múltiples muestras. Esto es útil para reducir el error de 
posicionamiento de un dispositivo GPS al estar situados en una misma posición durante un tiempo.

La opción “Registro” permite ir grabando datos, caracterizándolos con un tipo OCAD correspondiente. 
A cada elemento diferente (una piedra, otra piedra, un muro, un camino, etc) se le asigna un ID (un número, 
por ejemplo). Se le asigna el tipo que es (punto, línea o área) y el objeto OCAD correspondiente. También se 
le puede dar una descripción. La lectura de las coordenadas se realiza pulsando sobre el botón “Centroide”. 
Pulsando sobre “Añadir” se crea dicho registro. Pulsando sobre el botón “Rec” se comienza una grabación 
automática. Esto es útil para elementos lineales como caminos. Al comienzo de un camino se establecen los 
datos (ID, tipo, objeto OCAD y descripción). Se pulsa el botón Rec y se comienza a andar. Al llegar al final 
(o cuando se desee), se pulsa el botón Stop para detener la grabación. Entre los campos y los botones se 
muestra un texto que indica cuántos puntos han sido recogidos hasta el momento.

Cada objeto tiene que tener un mismo ID. Por ejemplo, cuando se comienza un camino se pulsa el botón 
“Nuevo ID” para que el programa asigne un valor. Entonces se establece el tipo y el símbolo OCAD que le 
corresponde. Luego, o bien se graba la secuencia de puntos (pulsando primero Rec y después Stop) o bien se 
van añadiendo puntos de forma manual. Esto último se hace pulsando el botón Centroide. La pantalla del 
centroide va dibujando puntos de forma continua. Cuando el usuario da por buena la lectura, regresa a la 
pantalla anterior y pulsa el botón “Añadir” para que quede almacenado en memoria. Si se cambia de objeto 
(otro camino, una piedra, un muro o lo que sea) se vuelve a pulsar el botón “Nuevo ID” y se comienza de 
nuevo.

OJO: volver al menú principal y pulsar Archivo → Grabar, para que los datos en memoria se vuelquen al 
archivo Registros.xml y no se pierdan en caso de un reseteo del dispositivo.



La opción “Eliminar” muestra un listado de los registros que se han ido grabando, de moderno a antiguo. 
Se puede seleccionar uno o varios y se pueden eliminar. Esto es útil por si se ha cometido algún error de 
grabación que se quiera arreglar en el momento.

La opción “Configurar” permite establecer algunos parámetros necesarios para el buen funcionamiento 
del programa. Esta pantalla es la primera que un usuario tendría que visitar para que el programa funcione.

Los primeros parámetros (Puerto COM, baudios, Bits Palabra, Bits Stop y Paridad) permiten configurar la 
comunicación con el GPS. Son los datos de una comunicación a través de puerto serie y se tienen que 
consultar en la información del propio dispositivo o del PC. El siguiente parámetro (Path XML) establece de 
dónde se lee y dónde se guarda el fichero “Registros.xml”. El valor de Escala se utiliza en la generación del 
fichero OCAD, ya que el usuario tiene que seleccionar una escala para el mapa que se va a generar. El último 
parámetro es el intervalo de tiempo (en mseg.) que se va a dejar entre lectura y lectura cuando se está 
realizando una grabación automática de registros. La necesidad de refresco no es la misma andando que 
moviéndose en bicicleta, por ejemplo.

NOTA PARA ANDROID: la configuración del GPS Bluetooth en Android sólo requiere que se escriba 
en el campo Puerto COM el nombre con el que se identifica. Esto se puede saber yendo a la sección de 
Ajustes → Conexiones y Redes → Bluetooth del dispositivo Android. Los otros campos (baudios, Bits 
palabra, Bits Stop y Paridad) no tienen sentido en este caso.

NOTA PARA ANDROID: la aplicación se instala por defecto en /mnt/sdcard/JARU. Ese es el path a 
utilizar en el campo Path XML. Ahí se grabarán todos los ficheros: Registros.xml, Registros.gpx, los mapas 
OCAD que se vayan generando y también los productos del editor de trabajo de campo.



Detalle de funciones. Menú Trabajo de campo.

Este menú corresponde a las opciones necesarias para el funcionamiento correcto de la tablilla de dibujo 
virtual. La opción “Brújula” no está operativa en la actualidad. Hay una opción adicional que no aparece en 
este gráfico y se llama “Exportar Bocetos”, que se verá más adelante.

La opción “Configuración” sirve para dar de alta los elementos de dibujo necesarios. 

La tablilla virtual utiliza una imagen de fondo sobre la que dibujar, de la misma manera que un cartógrafo 
la prepara antes de ir al campo. Será una imagen de una zona en concreto, compuesta de información variada 
a partir de una ortofoto y una superposición de curvas de nivel, datos de catastro, datos de urbanismo, etc, 
puesta a una determinada escala. En este caso, más que escala se utiliza el concepto de factor de resolución o 
coordenadas de las esquinas sup-izq e inf-der. Si la imagen que se va a utilizar contiene información de 
georreferenciación, esta suele venir en un fichero que se llama igual que la imagen, pero cuya extensión acaba 
en w y depende del tipo de formato (por ejemplo, para una imagen .tif el fichero de mundo es .tfw; para una 
imagen .jpg el fichero de mundo es jgw; para un .bmp será .bpw; etc).

OJO: en este programa, usar el formato JPG para las imágenes de fondo.

Si existe el fichero de georreferenciación, el programa es capaz de reconocer la información de 
coordenadas en el momento en que se selecciona el archivo de la imagen. En caso contrario, el usuario tendrá 
que escribir manualmente los valores de dichas coordenadas.

El valor de zona UTM lo tiene que escribir manualmente el usuario, SIEMPRE. Esto sólo es necesario 
para uno de los modos de dibujo que se explican a continuación, pero hay que hacerlo.

Además de la imagen de fondo, el programa utiliza tres imágenes de boceto. Una se utiliza para dibujar 
puntos y líneas. Otra para dibujar áreas de vegetación. La última se deja para el trabajo en sucio. La primera 
vez que se selecciona una imagen de fondo, el valor de la casilla “Boceto” se tiene que dejar en blanco, ya que 



el programa genera los bocetos de forma automática. El programa les da un nombre de forma automática, 
pero se pueden identificar fácilmente por que una tiene el sufijo “_Puntos”, otra “_Areas” y otra “_Sucio”. El 
formato en el que se crean estos bocetos es el PNG (para poder usar transparencias fácilmente).

OJO: lo mejor es que el usuario prepare la imagen de fondo con información de georreferenciación. Sino, 
para que el editor funcione de una forma precisa tendrá que dar de alta los valores de coordenadas y factor de 
escala de forma manual, por ejemplo, escribiendo las coordenadas UTM de la esquina superior-izquierda e 
inferior-derecha de la imagen.

Después de la primera vez que se han creado los bocetos de forma automática, si el usuario cambia de 
imágenes para trabajar en otro lugar, siempre podrá volver sobre un material anterior. Para ello, seleccionará 
la imagen de fondo y uno de los bocetos existentes (da igual que sea el fichero correspondiente a los puntos, 
áreas o sucio). El caso es elegir imagen de fondo y un boceto.

La casilla denominada “Priorizar calidad” sólo tiene sentido en la versión para PC. En la versión Android 
se ha bajado intencionadamente la calidad del editor de trabajo de campo (perfección y suavidad de las líneas 
dibujadas) para no comer los recursos del dispositivo y que con ello se reduzca drásticamente el rendimiento.

NOTA PARA ANDROID: los smartphones y tablets Android suelen tener una memoria mucho más 
limitada que un PC. La versión actual del programa hace una gestión poco eficiente de las imágenes (A 
MEJORAR), lo cual hace que se consuma mucha memoria. Por ello, para evitar que el programa se cuelgue 
intentando cargar la imagen de fondo y los bocetos, es necesario limitarse a trabajar con superficies muy 
pequeñas. Así como en la versión PC se puede crear una imagen de fondo que abarque hasta un par de Km2 

sin problemas, en la versión de Android sería conveniente no pasarse de 0,25 Km2. Esto dependerá 
lógicamente del dispositivo en concreto, con lo cual es bueno hacer pruebas previamente y acostumbrarse a 
conocer hasta dónde se puede llegar en el manejo de imágenes.

La siguiente opción de menú es el “Editor” de trabajo de campo. Sirve para dibujar sobre los bocetos de 
la imagen de fondo que se ha establecido en la pantalla de configuración.

En la figura anterior se muestra un fondo que corresponde a la imagen de intensidad de un conjunto de 
datos LIDAR, la cual se utiliza como base para el trabajo de campo. Sobre ella se han superpuesto todas las 
capas correspondientes a los bocetos para dibujar.

La parte inferior la ocupan unos botones de selección. Son los siguientes:



• Lápiz  : selecciona el modo para dibujar. Actualmente, el editor está preparado para su uso con 
tabletas digitalizadoras y pantallas táctiles. El modo de dibujo es a mano alzada.

• Goma  : selecciona el modo de borrado.
• Flecha  : permite marcar con el ratón un punto en la imagen.
• Mano  : permite mover la imagen.
• Lupa   (más, menos, todo): permite acercar o alejar la imagen.
• Satélite  : permite activar o desactivar el GPS. Si está activado, se muestra una cruz de color naranja 

en la posición que ocupa actualmente el receptor.
• Salir  : cierra la ventana del editor y graba los cambios. A lo largo de una jornada de trabajo será 

necesario pulsar el botón de salir periódicamente para que los cambios queden almacenados. Al 
volver a entrar en el editor se respecta la posición y el nivel de zoom utilizados por última vez.

La parte derecha la ocupan unos selectores que permiten establecer el modo de dibujo, el tipo de dibujo, 
color, etc. Son los siguientes:

• Capas  : permite seleccionar en qué capa se quiere dibujar (puntos, áreas o sucio) y también qué capa 
se quiere visualizar (puntos, áreas, sucio, imagen de fondo y datos vectoriales). Sólo se puede dibujar 
en una capa a la vez, pero se pueden visualizar 0, 1 ó todas las capas.
o La ocultación de capas facilita la tarea de dibujado. A veces interesa ver una sola capa; otras 

veces interesa ocultar la imagen de fondo para ver más claramente lo que se ha dibujado; otras 
veces interesa volcar en pantalla lo que se ha estado recogiendo desde la pantalla de registro 
de datos vectoriales (menú Gestionar  Registro)

• Color  : permite seleccionar el color del rotulador. Se han escogido los colores que se suelen llevar al 
campo en una tablilla de verdad. (Negro: caminos, objetos hechos por el hombre, objetos rocosos; 
verde: áreas boscosas, elementos puntuales de vegetación; rojo: elementos de tierra, áreas abiertas; 
azul: elementos de agua; gris: afloramientos rocosos)

• Grosor  : permite seleccionar entre dos grosores del rotulador, uno más fino que el otro. El tamaño 
de los objetos habrá que practicarlo para encontrar una buena correspondencia con el resultado 
final en un mapa, ya que aquí se utilizan niveles de zoom que no corresponden con una escala de 
trabajo en concreto.

• Modos de dibujo  : el modo por defecto es el raster. Se trata de dibujar a mano alzada igual que se 
haría en una tablilla. Luego, la imagen resultante se tiene que abrir en OCAD para poder editar el 
mapa final. Sin embargo, se ha añadido un modo de dibujo vectorial. Todo lo que dibuje a mano 
alzada quedará registrado como objeto vectorial y se podrá caracterizar con un tipo OCAD. Y en 
modo vectorial, cuando se seleccione la goma de borrar se podrán eliminar objetos vectoriales ya 
registrados. En el modo vectorial, los elementos de tipo punto se dibujan como cruces de color gris; 
los elementos lineales y de área se dibujan como líneas delgadas de color gris (igual que cuando se 
importan en OCAD datos que no vienen caracterizados con un tipo de objeto OCAD)

• Coordenadas, distancia y rumbo  : sirve para dibujar líneas desde un punto (normalmente el centro de 
la imagen, aunque el usuario puede seleccionar cualquier lugar utilizando el botón que tiene como 
icono una flecha) estableciendo una distancia (en metros) y un rumbo (de 0 a 359 grados contados 
en sentido de las agujas del reloj)

En la siguiente figura se representa la misma zona que antes. Sólo se visualiza la capa de puntos/líneas. Se 
ha situado el cursor en una coordenada y desde allí se ha mandado dibujar una línea de 50 m con un ángulo 
de 45 grados. La línea es gruesa y de color rojo (línea que está en la parte superior-derecha de la imagen).



Observación: la imagen se ve pixelada porque el programa puede configurarse para dar prioridad al 
rendimiento o a la calidad de la imagen. En este caso se ha decidido trabajar priorizando el rendimiento, ya 
que los dispositivos móviles suelen ser menos potentes que los de sobremesa y se podría estar penalizando 
mucho el refresco de los elementos si se diera prioridad a la calidad.

La siguiente figura representa el trabajo con el editor pero en modo vectorial. En la esquina superior-
izquierda de la ventana se puede ver, con respecto a la figura anterior, que se ha añadido un elemento de tipo 
punto y otro de tipo línea. Para condensar un poco más la información, se ha seleccionado el modo goma y se 
ha pulsado sobre la imagen. Así, se muestra un cuadro adicional que presenta los últimos objetos vectoriales 
que se han añadido, que son precisamente los que corresponden a este ejemplo. Desde este formulario se 
pueden borrar (por ejemplo, si se ha cometido algún error de digitalización).



La siguiente figura muestra una vista global del material de trabajo de campo, habiendo alejado mucho la 
imagen. Se puede distinguir una superposición de la imagen de fondo con las capas de los bocetos. También 
se puede distinguir que hay una parte del mapa que ya ha sido editado en OCAD.

Existe una opción más ligada al editor de trabajo de campo. Se llama “Exportar bocetos”. Cuando se 
pulsa esta opción, el programa graba los mismos bocetos en formato JPG georreferenciado. Por ejemplo, si 
los bocetos se llaman: “imagen1_Puntos.png”, “imagen1_Areas.png” e “imagen1_Sucio.png”, el resultado de 
esta opción es que se crearán, en la misma carpeta, los siguientes ficheros: “imagen1_Puntos.jpg” e 
“imagen1_Puntos.jgw”, “imagen1_Areas.jpg” e “imagen1_Areas.jgw”, “imagen1_Sucio.jpg” e 
“imagen1_Sucio.jgw”. Las últimas versiones de OCAD son capaces de cargar plantillas de forma automática 
cuando se trata de imágenes georreferenciadas, esto es, situándolas en la posición y tamaño correctos con 
respecto al resto del mapa. Así se facilita enormemente la carga de los bocetos dentro del mapa de OCAD 
que estamos editando.



Sacando partido al OCAD 6
Quien disponga de las últimas versiones de OCAD, 9 ó 10, y un dispositivo tablet PC con sistema 

operativo Windows, probablemente no encuentre de mucha utilidad un programa como éste. Actualmente, 
los fabricantes se están pasando a otros sistemas operativos para sus dispositivos móviles, como por ejemplo 
Android, y resulta un poco más difícil encontrar modelos corriendo con el sistema Windows. OCAD no tiene 
una versión que no sea Windows, así que cualquier otra aproximación tecnológica no va a funcionar. Además, 
los tablet PC que hay actualmente son sensiblemente más económicos si llevan Android que si llevan 
Windows. Y muchos incorporan GPS e incluso brújula digital, o también sensor de inclinación. El software 
de OCAD no es barato y no todo el mundo está dispuesto a asumir el coste de una licencia.

Existe una versión de OCAD gratuita. Se trata de la versión 6. Las últimas versiones han añadido una 
gran cantidad de opciones que facilitan tanto la labor de dibujado como, sobre todo, la preparación del 
material para realizar ese dibujado. Incorporan la posibilidad de trabajar con múltiples plantillas a la vez, 
admiten formatos de imágenes georreferenciadas que se ubican en su lugar y tamaño de forma automática, 
importan datos en más formatos externos (como por ejemplo el GPX), etc. Sin embargo, aunque mucho 
menos potente, al menos la versión 6 de OCAD permite editar un mapa con todas las garantías de estar 
dentro de la norma ISOM.

Las funciones de este programa están pensadas para facilitar un poco la labor de incorporar al OCAD 6 
materiales de utilidad a partir de datos que se encuentran en otros formatos. Se pueden dar de alta registros 
vectoriales, con indicación del tipo OCAD que les corresponde. También se pueden importar datos 
procedentes de un GPS que están en formato GPX. Y todos esos datos se pueden volcar a un fichero OCAD 
6, el cual se puede abrir directamente con esa versión del programa. De esta forma, la edición del mapa en 
OCAD se puede facilitar porque ya tenemos un material preparado para ser utilizado por ese programa.

Esta es una posible secuencia en los pasos del trabajo preparatorio, de campo y de edición:

- Resumen de software gratuito necesario:
o OCAD 6, de OCAD AG (admite BMP, DXF y conexión a GPS en tiempo real)
o ER Viewer, de ERDAS (visor de formatos de imágenes georreferenciadas y conversión entre 

formatos)
o GPSLogger, para grabación de datos vectoriales, edición gráfica, exportación a OCAD 6

- Obtención de documentos fuente:
o www.ign.es -> Centro de Descargas

 Es necesario registrarse (gratuito)
 Uso de material gratuito si no forma parte de una actividad económica
 Formatos: ortofoto (ECW georreferenciado); topográfico (TIF georreferenciado)

o Servicios de urbanismo de ayuntamientos
 Formatos: topográfico en papel; topográfico + servicios en DXF

o Tracks y Waypoints de GPS
 Formatos: GPX

o Datos vectoriales de otras fuentes SIG
 Formatos: SHP

- Extracción de subconjuntos de interés.
o Imágenes en ECW

 Convertir a BMP georreferenciado (fichero imagen, JPG + datos de 
georreferenciación, JGW) -> ER Viewer

 Como mínimo, crear el BMP y anotar la coordenada de la esquina Sup-Izq e Inf-Der 
(necesario para OCAD 6)

o Imágenes en TIF
 Idem que anterior

o Datos vectoriales en GPX
 Importar en GPSLogger y, desde ahí, exportar a OCAD 6



o Datos vectoriales en DXF
 Directamente importables en OCAD 6

- Integración en OCAD 6
o Lanzar OCAD
o Asegurarse de que está habilitado para trabajar con coordenadas de mundo real: Options -> 

Preferences -> Real World Coordinates
o Crear un nuevo mapa: File -> New -> Orienteering map 15000
o Si se quiere trabajar sobre un mapa topográfico a 1:25.000:

 Dibujar un objeto cualquiera en el mapa (una curva de nivel, una piedra, lo que sea)
 Cambiar la escala del mapa: Extras -> Change Scale -> 25000

o Establecer un origen de coordenadas de mundo real, en algún punto real de nuestro mapa:
o Options -> Scales

 Horizontal Offset: coordenada horizontal del punto de referencia, en UTM
 Vertical Offset: coordenada vertical del punto de referencia, en UTM

o Abrir el mapa topográfico de fondo (el convertido a BMP en un paso anterior)
 Options -> Open Template...
 Seleccionar el archivo con el mapa topográfico
 Nos pide una resolución. El caso es que no lo sabemos bien. Pondremos 300 ppp.
 La imagen no podrá ser demasiado pesada, ya que el programa se puede colgar.
 Si la imagen se muestra en pantalla, ahora habrá que ajustarla para que coincidan las 

coordenadas de los extremos
• Options -> Adjust Template
• El proceso de ajuste se puede hacer en dos pasos:
• Ajuste de la esquina Sup-Izq: se hace clic en la esquina de la imagen y se 

vuelve a hacer clic en el lugar del mapa que corresponda con las coordenadas 
correctas.

• Ajuste de la esquina Inf-Der: idem
• Se pulsa Enter para acabar con el proceso de ajuste.

o En OCAD 6 sólo se puede tener abierta una plantilla, así que habrá que ir alternando orto y 
foto en distintos momentos, pero el proceso de ajuste es el mismo.

o Si es necesario, volver a ajustar el origen de coordenadas para que el punto de referencia 
coincida exactamente.

o Importar elementos vectoriales, desde archivos en formato DXF
o Convertir los objetos vectoriales en objetos de OCAD

- Edición del mapa
o Dibujar todos los elementos necesarios con las herramientas de OCAD.

- Exportación, impresión del mapa.



Anexo. Instalación y uso del programa en Android
La versión para Android se distribuye en forma de archivo APK. Basta con acceder a ese archivo desde el 

dispositivo y seleccionarlo para iniciar automáticamente el proceso de instalación.

El programa se instala y funciona desde la ruta /mnt/sdcard/JARU. Ahí es donde se grabará el archivo 
de datos Registros.xml y los demás ficheros necesarios para la importación/exportación y trabajo de campo.

Después de una sesión de trabajo de campo registrando datos a través del menú Registro, lo normal sería 
exportar los datos en formato OCAD o GPX, para pasarlos al PC de forma que se puedan usar más 
fácilmente, por ejemplo en el propio OCAD.

Cuando se está preparando una sesión de trabajo de campo y se quiere usar la parte del editor, desde el 
PC habrá que generar una o más imágenes de fondo. Recordar no crear imágenes muy pesadas porque es fácil 
que el dispositivo no pueda con ellas. Mejor preparar varias imágenes pequeñas que una grande. Habrá que 
conectar el dispositivo Android al PC para poder grabar en aquél las imágenes de fondo (hacerlo en el mismo 
path, /mnt/sdcard/JARU, para tenerlas bien a mano).

Al regresar a casa después de una sesión de edición de trabajo de campo, exportar los bocetos para 
generar unos archivos georreferenciados, conectar el dispositivo al PC y transferir esos archivos de forma que 
se puedan cargar directamente en OCAD. 

El programa permite el uso combinado de datos vectoriales (menú Registro) con datos Raster (menú 
Trabajo de campo). En ese caso, exportar todos los datos en sus diferentes formatos, transferirlos al PC y 
usarlos en OCAD directamente.

RESUMEN DE CARACTERÍSTICAS:
– Se puede usar en cualquier dispositivo Android, ya sea smartphone con pantalla pequeña o tablet de 

10 pulgadas. Las pantallas están diseñadas para que se vean suficientemente bien en cada uno de ellos
– Utilización de GPS Bluetooth externo para tomar datos de coordenadas
– Utilización de formato XML para el almacenamiento de los datos registrados con el programa
– Utilización de formato GPX, tanto para importar datos externos como para comunicarse con 

programas de terceros (por ejemplo, Google Earth)
– Utilización de formato JPG con fichero de mundo para utilizar imágenes de fondo en el editor de 

trabajo de campo y para exportar los bocetos para su uso posterior en OCAD
– Utilización de formato PNG para manejar fácilmente transparencias y así poder realizar edición de 

trabajo de campo de forma más cómoda
– El programa está traducido a tres idiomas: español, inglés y francés. El programa selecciona el idioma 

automáticamente según cuál esté definido en el propio dispositivo. Por defecto aparecerá en inglés

MEJORAS PREVISTAS:
– Uso de GPS interno al smartphone o tablet Android
– Gestión de gráficos eficiente para poder manejar tamaños de imágenes más grandes
– Herramientas de dibujo con respuesta gráfica más suave
– Traducir este manual a inglés y francés


